The User Manual of mpegSyntaxer – An MPEG-Video Syntax Viewer (version 1.0 beta)
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Introduction

This program is designed to support interactive visual view of MPEG-video syntax. The target users include:

· University teachers working in the area of multimedia processing;

· College students learning multimedia-related courses;

· Scholars involving in MPEG-related research projects;

· Researchers writing some MPEG-related papers, books or presentations;

· Programmers developing MPEG-related products.

This program contains two major functions: MPEG-video syntax parsing, interactive block/MB/slice/picture/frame reconstruction and display, and post-processing of the reconstructed pictures. At current stage, the following MPEG formats are supported: 

· MPEG-1/2 pure video (m1v/m2v);

· MPEG-1/2 PS video (mpg/mpeg/mpe).

In future versions, support on MPEG-1/2 TS videos, MPEG-4 videos, H.26x videos will be added. See the cover page for a snapshot of the working status of this program.

1 The Graphical User Interface

Run mpegSyntaxer.exe, one can see the starting screen as shown in Figure 1. The graphical user interface contains three parts: 1) a manipulate menu, two toolbars and a status bar; 2) the left pane of the main window (Syntax Window); 3) the right pane of the main window (Control/Display Window). 
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Figure 1: The starting screen of mepgSyntaxer.

The first toolbar contains shortcut buttons of the menu items in the “File” menu, and the second toolbar include some control for displaying function and searching function. The Syntax Window include a tree control for syntax display of the current MPEG-video file, and the Control/Display Window has two working modes: 1) the control mode – in this mode a control dialog is displayed as shown in Figure 1, which is in charge of the parsing procedure; 2) the display mode – in this mode a display area is maintained for the visual show of the reconstructed block, MB, slice, or picture, as shown in the cover figure. After loading an MPEG file, one can switch between the control and display modes by double-clicking the left mouse button within the Control/Display Window.

In the following, we will give a brief description of all functions of mpegSyntaxer, from opening an MPEG-2 example video to processing the reconstructed picture with some specific operations.

2 File and Syntax Functions

2.1 Open an MPEG file

There are three ways to open an MPEG file: 1) selecting the menu item “File”-“Open…”; 2) clicking the first button in the left toolbar; 3) double-clicking the left mouse button in the Syntax Window.  After loading the MPEG file, mpegSyntaxer will automatically load the sequence header and extensions (if any) of the file.

2.2 Parse the MPEG file

In the Control/Display Window, click the “Parse” button, the active MPEG file will be parsed, until the “Stop” button is pressed. During the parsing procedure, one can click the “Pause” button to pause the procedure and then click the “Resume” button to resume it. One can parse the MPEG file from a desired starting point by click one of the check boxes lying below the slider control. 

For PS MPEG-video, one can choose three types of parsing modes: “Parse Program Stream only”, “Parse the first Elementary Video Stream only” and “Parse Program Stream and the first Elementary Video Stream simultaneously”. For pure video file, only the second mode is valid. See Figure 2 for snapshots of the parsing procedures in the first two modes.
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(a)                                                                         (b)

Figure 2: The procedure of parsing an MPEG file: a) Parse the first Elementary Video Stream only; b) Parse Program Stream only.

2.3 View the MPEG-video Syntax

Once the parsing procedure is started, the Syntax Window will be timely updated to show parsed syntax elements and the parsing progress. The tree item corresponding to the first picture will be focused and collapsed once the parsing procedure is finished. The syntax in the level of elementary video stream is organized and displayed in the following multiple-level style.

Video Stream

GOP

Picture

Slice

MB

Block
The syntax in the level of program stream is organized and displayed in the following multiple-level style.

Program Stream

Pack

Packet

When program stream is parsed, all elementary streams will be displayed with a root item in the tree control, but for the current version of mpegSynatx only the first video stream may be parsed and displayed in detail.
Since there may be too many MBs in each picture, the syntax of MB level is not displayed by default, but a virtual item is inserted under each slice tree item. One can double click the left mouse button on this virtual item to parse all MBs in this slice, or click the right mouse button and select the corresponding menu item to parse all MBs in a slice or a picture. Similarly, when the program stream is also parsed, the packet load in each packet is also displayed as a virtual item. After parsing MBs in a slice or a picture, one can delete these MBs to release the occupied memory, by selecting the “Delete MBs in Slice” and “Delete MBs in Picture” items in the popup menu.

All syntax elements shown in the Syntax Window are compliant to the names occurring in the MPEG-1 and MPEG-2 standards. Some virtual elements are also displayed to facilitate the understanding of the syntax. At the block level, the raw syntax elements are shown together with the decoded DCT and Y-Cb-Cr matrices. See Figure 3 for a snapshot of the multiple-level display of the MPEG-video syntax.
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(a)                                                                            (b)

Figure 3: The multiple-level display of the MPEG-video syntax: a) elementary video stream; b) program stream.

Note 1: parsing all MBs in a picture may consume much time, due to the heavy computation load of inserting a large number of items into the tree control.

Note 2: parsing all MBs in a picture may consume a lot of memory, if the video size is very large. In this case, one should ensure that the system memory is sufficient. Generally speaking, at least 128MB memory is needed for a large MPEG-2 video. It is suggest that one should avoid parsing all MBs in a picture as possible as he can. The above-mentioned “Delete MBs in …” functions are useful to relax this problem.

2.4 Export the MPEG-Video Syntax

One can export partial syntax information of the MPEG-video to the clipboard, by clicking the right mouse button within the Syntax Window and selecting one of “Export …” menu items. As an example, the exported syntax texts under a specific block are shown in Figure 4.

[image: image7.jpg]File Edt Formakt “iew Help

#1: coded v-Block
raw DCT data (RLE)
do_dect_size=6 (111108, 5-hit wLC)
de_det_differential=40 (1010008, & hits)
det_diff=40
end_of_block (01108, wLCD)
pCT coefficients: QF [ul[vw] (8x8 matrix, before quantization)

40, a, 0, 0, a0, a, 0, 0
Ju a, a, a, a, a, a, o}
0, a, a, a, a, a, a, ¢}
aQ, 0, 0, 0, 0, 0, o, )
0, a, a, a, a, a, a, ¢}
aQ, 0, 0, 0, 0, 0, 0, 0
0, a, a, a, a, a, a, 0
Ju a, a, a, a, a, a, ¢}

pCT coefficients: Flu] [w] (8x8 matr1x, after guantization)
20, a, a, a, a, a, a, 0
0, 0, 0, 0, 0, 0, 0, 0
0, a, a, a, a, a, a, o}
a, a0, 0, 0, 0, 0, 0, 0
0, a, a, a, a, a, a, o}
0, a, a, a, a, a, a, 0
aQ, 0, 0, o, 0, 0, 0, )
0, a, a, a, a, a, 1

Pel values: pe1 Y[u][v] (8x8 matr1x, after IDCT transfurm)
168, 168, 168, 168, 168, 168, 168, 168
168, 168, 168, 168, 168, 168, 168, 168
168, 168, 168, 168, 168, 168, 168, 168
168, 168, 168, 168, 168, 168, 168, 168
168, 168, 168, 168, 168, 168, 168, 168
168, 168, 168, 168, 168, 168, 168, 168
168, 168, 168, 168, 168, 168, 168, 168
168, 168, 168, 168, 168, 168, 168, 168





Figure 4: The exported syntax texts under a block shown in Notepad.exe.

Note: the exporting procedure may be very time consuming, if the number of exported syntax elements is too large. It is suggested the one should avoid export all items in a video stream, especially when all MBs in one or more pictures have been displayed.

2.5 Search Syntax Elements

One can search some specific syntax elements in the parsed part of the MPEG-video via the search interface. To search a keyword occurring in some syntax elements, one can type the keyword in the edit control in the right toolbar, and then press <Enter> (or <F3>) key or click the search button ([image: image8.bmp] in Toolbar #2). Note that the search function distinguishes upper and lower characters. By default, the search function is carried out in the whole video stream. One can change the search range to a specific sub-tree, by clicking the right mouse button and selecting the menu item “Search Tree”.
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Figure 5: Searching the keyword “escape” in the MPEG file.

3 Display Functions

3.1 Basic Display Functions

One can double-click the left mouse button in the Control/Display Window to switch between the control and display modes. The program can automatically display the current focused syntax elements, which may be a block, an MB, a slice, or a picture. A dashed blue box shows the boundary of the MPEG-video, and a solid red box shows the focused syntax element for display. When the whole picture is focused, the red box shows the display area defined in Sequence/Picture Display Extension of the MPEG-video file. When the root item of the picture is focused, the picture will be displayed following the aspect ratio information defined in Sequence Header. 
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Figure 6: Two display styles of the reconstructed picture.

3.2 Picture Display Types

There are some different picture display types to support different needs of end users: Auto, Raw, Diff[0], Diff[1] and Null. 

· Auto is a default setting, and used to display the original picture. If the reference pictures of B/P-picture cannot be found, Auto will be changed to Raw.

· Raw is valid for B/P-pictures and means displaying the picture reconstructed from the raw data (without motion compensation). 

· Diff[0] is valid for B/P-pictures and means displaying the difference picture between the current picture and the first reference frame.

· Diff[1] is valid only for B-pictures and means displaying the difference picture between the current picture and the second reference frame.

· Null is a setting for some special display effects, combining with the field selection. In this display type, the current selected frame or field is cleared to be the middle background color.

See Figure 7 for the display results of the first four picture display types.

[image: image12.jpg]3

View Processng Help

5 nﬂnmaanou Colors ..

Ready

= e 71 G

BTN - | [Tre Fiome <] I DisplayMys [0 ot =] I~ MBGid |
v

(5[] Picure Header
o[ Fieture Coding Extenson
T Frames forPredictons




 [image: image13.jpg]S o] E &)X

MPEG-Video Syntax Viewer - hhishort.n ~ CHChiness (PRC) e Chinese (PRC) B
E

"C:\~hooklee\Research\@Hongkong\Video Resources\Source Codes\#m...\khishort.m2v" (291,071 bytes)
e




(a) Auto                                             (b) Raw
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(c) Diff[0]                                        (d) Diff[1]
Figure 7: A reconstructed B-picture in the first four display types.

3.3 Field Options

Sometimes users want to display a single field of a frame picture, to get a special display result. By choosing different field types in the second list box in the right toolbar, one can define three different options:

· “The Frame” means displaying both fields.

· “Top Field” means displaying top field only.

· “Bottom Field” means displaying bottom field only.

Note that this option is not valid for field picture. See Figure 8 for the display results of the first two field options.
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Figure 8: The displayed pictures in “The Frame” and “Top Field” options.

3.4 Color Component Options

By default, the picture is displayed by decoding all the three color components: Y, Cb and Cr. One can redefine the display in only a single color component. Three sets of color components are supported in mpegSyntaxer: Y-Cb-Cr (i.e., Y-U-V), R-G-B, and Yellow-Magenta-Cyan. One can choose the corresponding items in “View” menu to activate a color component. See Figure 9 for the display results corresponding to the nine color components.
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(a) Y                                         (b) Cb                                              (c) Cr
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(g) Yellow                                     (h) Magenta                                    (i) Cyan

Figure 9: Displaying the picture with a single color component.

3.5 Selective DCT Matrix

One can define a selective DCT matrix to display the picture by setting some DCT coefficients to zeros. For example, one wants to see the display result when only DC coefficients are used for display. By clicking the menu item “View”-“Selective DCT…”, one can see the dialog as shown in Figure 10. In the selective DCT matrix, “0” means that the corresponding DCT coefficient will be set to be zero before carrying out IDCT to generate the picture. The four buttons, “All Ones”, “All Zeros”, “Some Ones” and “Some Zeros”, are used to facilitate users to set the matrix. The display results corresponding to two selective DCT matrices are shown in Figure 11.
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Figure 10: The dialog for defining selective DCT matrix.
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(a)                                                                            (b)

Figure 11: Displaying the picture with two different selective DCT matrices: a) only DC coefficients are used; b) only AC coefficients are used.

3.6 Live De-Interlacing

For interlaced MPEG-2 videos with fast motions, there may exist obvious artifacts between two fields, which may significantly reduce the visual quality of the reconstructed frame. To overcome this problem, one can activate live de-interlacing operations to filtering such artifacts, by checking the “View”-“Live De-Interlacing” menu item. Figure 12 gives a comparison of the display results without and with live de-interlacing. Note that field smooth can also be carried out after the picture is reconstructed without live de-interlacing option (see Sec. 5.2).
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Figure 12: A comparison of the display results without (left) and with (right) live de-interlacing. 

3.7 Auto-Picture Mode

When the current selected picture is the last picture in the current GOP, one cannot directly go to the next picture (i.e., the first picture in the next GOP), by pressing the down-arrow key. When the current picture is the first picture in the current GOP, the same problem exists if one wants to directly go to the previous picture, i.e., the last picture in the previous GOP. In mpegSyntaxer, a function is added to support this function: one can choose the “View”-“Auto-Picture Mode” menu to enable this function. In Auto-Picture mode, one can quick view the parsed video picture by picture, by pressing the down-arrow key continuously. This is useful to find an interested picture more quickly.

3.8 MVs Display

By clicking the “Display MVs” check box in Toolbar #2, one can overlap motion vectors in the displayed picture. One can also select different types of MVs for display, by selecting different item in the list box at the right side of the “Display MVs” check box. Also, it is possible to display only some kinds of selected MVs, such as forward MVs or backward MVs, which is useful for users to plot figures for their paper, books or presentations. See Figure 13 for two snapshots of this function. Note that the forward and backward MVs are displayed in different colors (yellow and magenta, respectively), both of which can be changed by users by clicking the “Colors …” button in Toolbar #2 (see Sec. 4.9).
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Figure 13: The display of MVs with (left) and without (right) the picture. Note that in the right sub-figure, the default colors of backward MVs and the picture background are changed to get a more elegant display.

3.9 MB Grid Display

By clicking the check box “MB Grid” in Toolbar #2, one can further overlap the MB grid on the displayed picture and MVs (if any), as shown in Figure 14. The default color of the MB grid is cyan, which can be changed by users by clicking the “Colors …” button in Toolbar #2 (see Sec. 4.9). In future versions, a new function is to be considered – plotting the MB grid in a transparent mode.
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Figure 14: The display of the MB grid over the reconstructed picture.

3.10 Customizing the Colors

By clicking the “Colors …” button in Toolbar #2, one can define the colors of the following items: the picture background, the field background (when only one field is parsed or displayed, this color is used to fill another filed, which is different from the picture background), the focused box, the video boundary, and the MB grid. Figure 15 shows the graphical user interface of this function.

The default colors of the seven items: the picture background – the background color of the dialog defined in Windows; the field background – the middle gray defined in the MPEG-video file; the forward MVs – yellow; the backward MVs – magenta; the focused box – red; the video boundary – blue; the MB grid – cyan.
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Figure 15: Customizing the colors.

3.11 More Complicated Display Results

By combining the above display functions, one can get some special display results. Here, two simple examples are given: a) for a frame picture, by selecting top field, and then select Null display type, one gets Figure 16a; b) by choosing different color components for different slices of a picture, one gets Figure 16b. One can see that it is possible to generate very complicated display results. 
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(a)                                                                            (b)

Figure 16: Two special display results of the picture.
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Figure 17: A BMP file generated with the “Save Snapshot” function.

3.12 Save the Display Results

With the items in the “File” menu and the shortcut buttons in Toolbar #1, some different saving functions are provided: “Save Frame”, “Save Top Field”, “Save Bottom Field”, “Save MBs (big)”, “Save MBs (small)” and “Save Snapshot”. The first three functions are used to save the current frame, top field and bottom field, respectively, and the other three functions are described as follows: “Save MBs (big)” saves the focused MB or slice as a graphics with the same size as the video; “Save MBs (small)” saves the focused MB or slice as a graphics with the same size as the MB or the slice itself; “Save Snapshot” saves the current screen within the video boundary (including MVs, MB grid) as a graphics with the same size as the picture. The output format of the saving functions is BMP. Figure 17 gives a BMP files generated with the “Save Snapshot” function.

4 Processing Functions

In mpegSyntaxer, some basic image processing functions are provided for the reconstructed picture. One can carry out any processing function by selecting the corresponding item in the “Processing” menu. Note that any new invokes of display or parsing functions will change the display obtained with these processing functions. 

4.1 Negative

This function displays the negative of the current picture. When only one single color component is activated, the two inactive color components will not be changed. See Figure 18 for two display results.
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(a)                                                                         (b)

Figure 18: The display results of two negative pictures: a) with three active color components; b) with one active color component – Yellow.
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Figure 19: The GUI of adjusting the RGB Gamma values with the preview function.

4.2 Gamma Correction

This function allows users to adjust the brightness and contrast of the reconstructed picture via the Gamma correction mechanism, where three Gamma values are defined to control a nonlinear transforms corresponding to Red, Green and Blue color components, respectively.

4.3 Smooth

Some different smoothing functions are supported in mpegSyntaxer: de-interlacing (which corresponds to field smoothing
), uniform smoothing, Gaussian smoothing and median filtering. All the smoothing operations are based on 3x3 filter kernels, and the median filtering is based on a cross filter structure. The effect of the uniform smoothing is shown in Figure 20. Note that field smoothing is also supported as a live setting of the display functions discussed in the last section (see also Sec. 4.6).
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Figure 20: The display result of uniform smoothing of a picture.

4.4 Sharpen

As inverse of smoothing operations, sharpening operations are also supported. A weak and a strong sharpening operations with 3x3 kernels are provided. See Figure 21 for the display results of the two sharpening operations.
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(a)                                                                         (b)

Figure 21: The display results of a picture: a) with the weak sharpening operation; b) with the strong sharpening operation.

4.5 Edge Detection

The function of edge detection is also supported in mpegSyntaxer, with a Laplacian 3x3 kernel. One can designate three different background colors: black, white and middle gray. Two example display results are shown in Figure 22.
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Figure 22: The display result of edge detection of a picture with black (left) and middle-gray (right) backgrounds.

4.6 Emboss

Embossed pictures are supported with four different directions: left-up, left-down, right-up, right-down. Two example display results are shown in Figure 23.
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(a) left-top                                                              (b) right-down

Figure 23: The display results of two embossed pictures in two different directions.

4.7 Flip

The horizontal and vertical flipping (mirror) operations are also supported, as shown in Figure 24. Note that the dispaly of MVs will not be changed with such flipping.

4.8 Combined Processing Operations

All the above processing operations can be freely combined to obtain some more complicated display effects; for example, one can smooth the reconstructed picture, and then sharpen it and finally get the edges. At any time, by choosing the menu item “Processing”-“Restore”, the original reconstructed picture will be restored.
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Figure 24: The display results of the flipping operations in vertical (left) and horizontal (right) directions.

5 Functions to be Added in Future Versions

5.1 More Elementary Video Streams

5.2 More Processing Functions (and a Plug-In Interface)

5.3 More MPEG-Based Video Formats: VCD and DVD formats, etc.

5.4 MPEG-2 Transport Stream

5.5 Multiple Videos (for Comparison)

5.6 H.264 (MPEG-4/AVC)

5.7 MPEG-4

5.8 Audio Stream (and Other Data Streams) 

5.9 Video Syntax Editing

� Note that some advanced techniques can be used to realize high-quality de-interlacing. For mpegSyntaxer, we just use a simple filed averaging (smoothing) filter to realize this function. Some more de-interlacing techniques may be added in future versions for academic needs. 
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